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Hello, Mr. Micko. More and more people are
learning to code and their works are so funny.
And | also want to design my own works!

Well? Sweetie, what kind of works do you prefer? ? 5

| wanna make a light sensitive lamp. \
| want to make a birthday gift for my best

friend, like a colorful music box.

| want make a remote car to my classmates.

And | want to make a door that | can open it
when sitting in a sofa.

I, | want to make all of these interesting DIYs!

Adorable! Let me infroduce a tool to make
them all, a magic graphical coding software
named Mind+. And many new things, such as
electronic hardware with many functions and
a microcontroller micro: bit.

\_

()3 But Mr. Micko, | am afraid | cannot. | know nothing about
AL programming. It seems too hard to learn programming.
S

Do not worry~ Even though we do not
know complex codes, we can make
many smart devices.

Really? Great! Let's begin our programming
QE with Mind+ and micro: bit!
N\




Welcome to the DFRobot blog: hitps://www.dfrobot.com/blog-tag-microbit.html
7 /115

With so many different graphical Programming software products on the market, how
can you get the right one? It may disappoint you when you found that your software
only supports some certain hardware and robots or even cannot work with any
hardware at all. Where to find a software with all you wanted?

Why not try our Mind+ graphical Programming software!

Mind+ is a graphical Programming platform that can support all kinds of open source
hardware such as Arduino, micro: bit. It is not only suitable for primary and secondary
school students, but also able to provide a great learning environment for makers who
want to improve themselves by studying high-level Programming language such as
Arduino, python, ¢, c++ etc. Drag and combine code blocks to make programs, easy
to find the joy of creating.

From beginners to experienced makers, Mind+ can satisfy all your needs: learning
Programming, running programs without downloading, experiencing loT(Internet of
Things), sharing ideas with Mind+ community and so on.

Come and play with Mind+, more surprises waiting for you!

Open the webpage and download: hitp://mindplus.cc

Figure 1.1.1 Mind+ Download Interface


http://m/
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After downloaded and installed the software, open and click “Learning” to

learn how to install driver.

1. Click to open Learning ->Video Tutorials.

Official Documents
I " Upload arduino C
Online Forum
Control Auto Generate | Manual Editing
~ Video Tutorials
Control
1 § 1+ void setup() {
O Example Prograrg B
[e
'pe.ria'cr o
riables Click the video tutorials
My to get started
Blocks
mpython

:

Figure1.1.2 Video Tutorials

2. Click the related tutorial, and play the video.

7 ¥A |

\ micro:bit
\a BB
~ L/ Y Y

Feature diagram micro:bit calibration

Play the video

Figure 1.1.3 Click to play the video

3. Install the SerialPort driver according to the instruction.

And you just need to install the driver for once.

Lo
e}
Jpload arduino €
Open Device Manager
Control o o 1 Generate | Manual Editing
- Install SerialPort Driver -
Control ; ;
1 1% void setup() {
Operat
perator: 5
Variables Install the SerialPort Driver

1.1.4 Install SerialPort Driver
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STEP3: Switch to “Code” mode (The tutorial is based on “*Code” mode).

1. Click “Code" icon at the right corner to switch mode.

2. Switched to "Code"” mode successfully.

el EZER o
Costumes Sounds Pythol bd deyi ]
@ wotion Click icon “Code”
Moti
:‘m movemsleps
éMind+ scratch (RN
@ contol | Switch to “Code” j l
Control | g "
1 p d
. o ) . | 3
) o N . 4 4~ void loop() {
(Operator: = 3 P
J 6
. 7
Variables I

Figure 1.1.5 Switching mode

_ Mr. Micko, what'’s the difference between
o these 2 modes?
b .

TS

My little friend, the mode Scratch will execute script
programs in hardware and Mind+ stage inreal time. But
the mode Code will upload programs to hardware
devices first then execute.
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To convenient the operation, first we should be familiar with the basic functions
of the software’s interface. If we compare the Mind+ software as a stage, what

are the functions of its different sections?

- Menu Bar
Upload arduino C
Control Auto Generate | Manual Editing
Control
1 1+ boid setup() {
3
o ;
erator: 4~ void loop() {
p 10 5
3
w 7
ariables
P Code
v
My
Blocks Scripi

Serial Port
Command Q

Figure 1.2.1 Mind+ Interface

Menu Bar: Software setting area.

This is the backstage of the whole “stage”. Without the help of the menu bar, we
can do nothing with this software. What functions are there behind the “stage”?

"Project”: create a new project, load a project, save a project, save a project
as.

“Learning”: where you can find lots of useful tutorials and examples programs.

“"Connect Device": detect the connected device, and you can select to
connect or disconnect the device.

“Scratch/Code” icon: switch mode to run program.

bk

Sefting” icon: set the theme and language of the software; share and
learn on our community or E-mail us your feedback.
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This is the “tool section” of the stage. We need all kinds of tools to
give an excellent performance on the stage, and we can get more exira tools

in “Extensions” to support different hardware.

Here is the core of the “stage performance”. All performances will be
acted under the instruction of “script”. This is what we called graphical
Programming, easy and simple for beginners to understand. Just drag the code
blocks in the "Command” to here then you can program.

If you want to check the codes of the blocks in the “script”, this is the right
place.

How do you know whether you have made a successful performance?

-Interact with your audience. This is the place your audiences give you their
“opinion” about the performance. The downloading situation will be displayed
on there, so you can check whether your download is successful, or if not, what's
the reason. Besides, you can see the programs running here. The serial port
communication data will also be displayed. That is to say, if your micro: bit board
is connected with an external sound sensor, you can find the related data here.
This section also includes: serialport open/close, scroll display open/close, clear
output, baud setting, serialport input and output format control.
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Micro: bit is an open source hardware ARM-based embedded system designed
by the BBC. It has accelerometer, magnetometer, Bluetooth, three buttons and

a display consisting of 25 LEDs.

With micro: bit, you can create many interesting and cool things, for example,
use it as a mini-mobile phone; connect the board with phone through onboard
Bluetooth, then send commands to control the board by the phone; realize
telecommunication of multiple micro: bit boards via wireless connection to finish
tasks requiring long-distance conftrol; use magnetometer to make navigation
device....

Micro: bit is equipped with light and temperature sensors and other common
sensing devices, which means that it itself can produce a lot of common smart

products used in our daily life.

Figure1.2.1 Front of micro: bif Figure 1.2.2 Back of micro: bit

micro: bit and micro: bit Expansion Board

Limitation of micro: bit

1. micro: bit cannot directly drive devices requiring large currents like, motor, servo efc.
due to its poor drive ability, so edge connectors are necessary for connecting more
external devices.

2. The power supply and signal voltage of micro: bitis 3.3V, which cannot work together
with the common 5V electronic components.
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The advantages of micro: bit expansion board

1. micro: bit expansion board can easily lead out the extra pins of micro: bit, plug and
play, easy to use;

2. The expansion interfaces of micro: bit improve the safety and stability of connection.

3. Micro- USB external power port VIN can be used to provide extra power for external
electronic devices such as LED strip, servo etc. (USB wire still needs to be connected to
micro: bit when running the programs.)

4. Micro: bit expansion board comes with 3.5mm headphone jack and volume knob,
supporting direct connection of headphone.

3Pin fool-proof

connector
Edge connector —

for micro: bit

Xolume knob On/Off switch

ON OFF

Micro-USB
L Bexternal power port

IR
i C?
PO

‘Audio jack

The maximum rated current of micro: bit expansion board is
500mA. Please confirm the max power of your component. Do not
use the expansion board tfogether with high-power servo,
otherwise on-board units damage may occur. 7
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Please prepare a Windows computer and components as below before we get

started:
&l
[ I I |
A | I I |
[ |
BB BB ® | :
Figure 1.3.1 micro: bit Figure1.3.2 micro USB connector
STEP1: S
1. Click -> at the upper-left corner.
£
o.‘ | L SaveAs
1.3.3 Create a new project
2. (1) Click at the lower-left corner
(2) Click
(3) Click
]
i
=
Block: .
L2
Figure 1.3.4 Extensions Figure1.3.5 “micro: bit"

STEP2: Edit a simple program

Edit a program to display a pattern on micro: bit LED panel:
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1. Drag the blocks we do not need currently o “command area” to remove it.

Blocks

micro:bit

Control
=2 micro:bit starts
O tor:
perator &= when button A - pressed

Variables == when micro: bit p’a PO ~

My forever

Blocks il Drag the blocks we do not need currently

micro:bit i B ) to “command area” to remove it.

= o display built-in pattern
(GO EVN hello world

Figure1.3.6 Remove Blocks

2. Click “micro: bit” module

e

Variables (& when micro: bit pin PO~ c
. G® microzbit starts
[Vl G 9 when logo up ~ (@9 display pattern
Blocks

micro:bit

display built-in pattern

SN L H Click “micro: bit” module

(=9 stop animation

Figure 1.3.7 Click “micro: bit” module

3. Drag “display pattern” block onto “Script” area.
4. Place "display patitern” block under the “micro: bit starts” block

Control

Operator:

Place it under
“micro:bit starts” block

Variables
My
Blocks

ff = display pattern

micro:bit
(9 display built-in pattern

'GO IS hello world

Figure1.3.8 Programming
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STEP3: Upload fo device

1. Connect micro: bit board to your computer via USB, then the power indicator
on the board will light up.

Figure 1.3.9 Connect micro: bit to computer

2. Click “Connect Device” in the menu bar, then click “COM-micro: bit” in the
drop-down menu to connect micro: bit board to the computer.

3. When connected, edit your programs and click “Upload” to upload the
programs to your board (if the connection fails, then it will prompt “No
Device Connected”. There will be a prompt box to display the uploading
progress. When the program is updated, the prompt box will disappear.

Upload arduino C v
Auto G rate
ey Click
4+ voffs O ¢
5 “Upload”

Figure 1.3.10 Run the program

‘ Click device
begins with
: “COM_H

) > vhen logoup - |

micro: bit power indicator flashes only when uploading the program, and stops

flashing and keeps ON after the upload is completed.

Try uploading a program to your micro: bit board, and make the board display

an “love heart” for you!
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power indicator

BAYTE RY.

K l
BLE ANE«M_('_J N
)
B|C]
PROCESSOR

LCOMPASS @

s micro:bit

l.}lll.ﬂllfl.lllll.llf!.

Figure 1.3.11 Power Indicator

The basic usages of micro: bit was shown above. If you have any quires, please
feel free to contact us on our forum at hitps://www.dfrobot.com/forum/

Welcome to our DFRobot Community to find more tutorials and fantastic
projects, and of course you can also share your own projects or ideas on our
community. Looking forward to your log in!

How do you feel about these learning? Have
you improved yourself?

Of course! Mr. DFRobot, now | have a basic
knowledge about Mind+ and micro: bit.

And | can make a red heart! =

You are so smart! This is just a begin, we
will get to know more about Mind+ and
micro: bit in future. And you can use them
to do what you want.

Awesome! | will try my best.
Mr. Micko, please teach me.



https://www.dfrobot.com/forum/

Welcome to the DFRobot blog: https://www.dfrobot.com/blog-tag-microbit.ntml
18 / 115

Chapter 2: What Makes a Machine “Come to Life”

After reading the previous infroduction, are you itch to have a fry2 Now, let’s

begin our journey with micro: bit!

Project 1: The Mysterious micro: bit

1.Story of Cat and Micko

L Mr. Micko, | have found many emojis iﬁ
@ computer and cellphone. Like these, how
adorable they are!

7 N\
o o e o

- ©&_d

J

My dear, if you like it you can make your

own emojis.
(D4
@ Wow! Mr. Micko, please help me make it.
NEW, Then | can share it with my friends.

Do you remember the new friend micro: bit
we met in the last chapter? It will help you
make it.

oS
Yes, | remember. | cannot wait to make it.
NCW
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2.Micko’s Pocket

1 x micro: bit 1 x micro USB Cable

i .J

All necessary components are in the pocket of Micko.

3.Dream of Cat

There are 25 LEDs on board. And |
want to control all LEDs and show

different forms.

4.Micko’s Blackboard

STEP1: Connect micro: bit to your computer via USB cable.

Figure 2.1.1Connect micro: bit fo Computer
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STEP2: Programming

1) Open Mind+ software, click Project->New Project, and then select “micro: bit”

board from “Extensions”

Let's review the steps to select “micro: bit” board:
(1) Click "Extensions” at the lower-left corner

(2) Click "*Board”

(3) Click *micro: bit"”

f

2) Click “micro: bit" at the left side of command area, and find “micro: bif starts”

block, which is very necessary for editing your program.

ﬁm Project v Learning v Connect Device w

Blocks |

. microzbit

Control \
G® microbit starts
. 4 E® microbit starts
Operator:
o @D whenbutton A+ pressedfill forever

RELEERT 5 when microwbit pin PO - o

(YAl G © when logo up ~
@ display pattern

@9 display built-in pattern
[N hello world @

Figure 2.1.2 micro: bit starts

3) Drag “forever” block to the left to delete it.

m Project w Learning » Connect Device w

Blocks ‘
micro:bit
Control

Operator:

@2 microbit starts

@2 when button A - pressed
E® micro:bit starts

ALl G5 when micrombit pin PO+
My @2 when logoup ~
Blocks
EE @ display pattern
micro:bit

Drag the block we do not need

©3_ display buili-in pattern currently to the left to delete it.
@ display

a

Figure 2.1.2 Delete Blocks
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() () Ah ha? Mr. Micko, Why should we delete
@ the block forever? So, when will we use it?
N(W

Sweetie, the block forever (loop) is very
important. It is used to execute the code more
than once at least. But we do not need repeat
the program at here.

()
@ Okay, | got it. Every block has its own
N ¢ responsibility!

4) Click micro: bit module, and find “display pattern” block. Drag the block to

21 /115

script area and place it under “micro: bif starfs” block.

Project = Learning = Connect Device =
Blocks

@ @ when button A - pressed
Control

) @® when microsbit pin PO =
Operator:
. &= when logoup ~

Variables g

. = display pattern

My - @® micro:bit starts
SN - = display built-in pattern

&= display pattern
G (GO B hello world

micro:| bit

&= show =~ coordinates of po
e brghtne 9

Figure 2.1.3 Drag Blocks

5) Click the black square in the “display pattern” block we dragged to script
areqa, then we can start to design our own pattern. First, let’'s make a super

cute “love heart”.

@Mo Project v Learning » Connect Device v
Blocks

microzbit
Control
@D microcbit starts.

o !
Gl < when button A - pressed
. G2 microzbit starte
ASLEEl G5 when microwbit pin PO - o @ display patter I
v

[YYl = when logo up
Blocks
£ Bl < display pattern

micro:bit
@= display built-in pattern
@o display

.
Figure 2.1.4 Design a heart pattern
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6) Click "Upload” to upload the program to micro: bit board. Then, you will find

a “heart” on micro: bit LED panel.

“Upload”: Click
“Connect Device” in the menu bar, then click “COM-Micro bit" in the
drop-down menu to connect micro: bit board to the computer.

5. Design of Cat

Try making one virtual pet, imaging what it looks like?

) @0
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Project2: Flash the LED Light

1. Story of Cat and Micko

X Mr. Micko, the lovely little heart
hd

made last week is very interesting,
\(‘Q my classmates love it!

My dear, not just emojis, playing
mind+ and micro: bit can make
as much as you can imagine.

o8 Really?! Mr DFRobot, colorful
4

lights are my favorite things.
\(‘t Could | bring them home?

It's my pleasure to teach a
student who is fond of learning.
Okay, let's welcome a new
friend-LED lights.

\_

= icl Let’s do it now!
\‘ = ﬁ Fantastic! Le !
S
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2.Micko’ Pocket

v

1 x micro: bit 1 x micro: bit Expansion Board
[ ]
o2r @ -
1o o i
1 x LED Module 1x micro USB Cable

3.Dream of Cat: Light up LEDs

The LED is OFF, | want
light it ON. What
should | do?

o%

=
\(‘Q 000

4.Micko’s Blackboard

STEP1: Connect micro: bit board to micro: bit expansion board.

Mainboard

TS

\\'\\'\\\\\\‘X\X\\‘\‘\‘\‘\\\\\‘\

Expansion
Board

Figure 2.2.1Connection Method  Figure 2.2.2 Connection Diagram
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use of micro: bit board and micro: bit expansion board.

Mr. Micko, Why should we use these two
= boards together? Could we only use the
\(‘t main control board micro: bit?

Well, the reason why should we use the
expansion board has already explained in
the introduction of micro: bit.

STEP2: Connect the LED module to pin P1 of the expansion board.

will

Figure 2.2.3 Connect LED
STEP3: Programming

1. Open Mind+ interface, create a new project and select micro: bit
board in extensions. Scroll down the “micro: bit” blocks fo find “set
digital pin PO output LOW" block, drag it onto script panel. Then we
need to change “P0” to “P1", “LOW" to “HIGH".
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E e

°
°
-

e
@ setdigital pin PO+ output LOW.

@® setanalog pin PO~ outpt @D

n
@» set wireless channel @)

Figure 2.2.4 Set Digital Pin

~
: , Mr. Micko, | am confused. May | ask you

ions?
A@S some questions?

J

Okay, take it easy. If you have any questions, B
feel free to ask me.

J

90 The 1st question: Why should we change
@ PO to P1? Will we change the pin to P1
NEW, every time?

Little friend, pins are the way that module connected
to main board. Then we can control the module by
change pin value. In this project, the reason why we
change it to P1 is that the LED is connected to P1.

&S | see, so if module is connected to P2 then we
@ need to change the pin number to P2.
N® The 2nd question: What is high level and low level?

At first, we need to know when the digital pin output low level,
which means no voltage or low voltage, and cannot reach the
minimum voltage value to light ON the LED. But when the
digital pin output high level, which means it can reach the
kminimum voltage value to light it ON. So, the LED is ON.
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(== setdigital pin PO~ output HIGH =

(== setdigital pin PO~ output LOW -

Set the pin HIGH to turn on

Set the pin LOW to 'rurngff

\

Well, the high level is corresponding to light ON LED,
and the low level is corresponding to light OFF LED.
N . The last question: Why should we choose digital pin?
But not analog pin?

J

How observant you are!

The digital pin is used to control digital signal. But what is the digital
signal?

Take LED as an example, it only has 2 modes: ON and OFF, which
correspond to two modes of digital signals, high level and low level.
But the eye-protecting lamp, its brightness is adjustable. We can
change the brightness as we want. Here the way we control the
Iqmp brightness used the analog pins. j

:i Thank you! | will think it over. ]
Q

2. Drag the “forever” block out from “confrol” module, nest “set digital

pinl output HIGH" block in forever(loop) statement, and place them

under the main program. Then “upload” the program to your device.

G2 when microbit pin - PO -

Go display built-in pattern

2.2.5 Execution Interface



Welcome to the DFRobot blog: https://www.dfrobot.com/blog-tag-microbit.ntml
28 / 115

3. Result: the LED will be on when the code is uploaded successfully.

.
L L L LA LA MNREnnpnE 39§

Figure 2.2.6 Result

5.Dream of Cat: Flash the LED Light

Now | learned how to light
ON LED and | want the LED
can flash, which means
light ON for 1 second then
light OFF for 1 second.

&
L -00

6.Micko’s Blackboard

1) The connection is same as above. Create a new project to make the LED

flash.

2) How to flash the LED? Just let the LED repeatedly keep on for 1 second and
keep off for 1 second. To achieve that effect, we need to use “waif 1 sec”

block in “control” module.

gMind+

10 | (E® microzbit starts

ariables| § . : -f!:
. . ) (@9 setdigital pin P1~ output HIGH ~
vy [ R l ]

Figure 2.2.7 “wait 1 sec”
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()
Qb Mr. Micko, | remember! Here we can use "forever”
\(‘Q (loop) to keep execute the program.

Good memory! Yes, the loop block
‘if...then" is used to execute program again
and again.

3) Place "wait 1 sec” block under the “set digital pin P1 output HIGH" block so

as to let the LED keep on for 1 second then do the next action.

ﬁMinCh—

(9 setdigital pin P1~ output HIGH
1

Figure 2.2.8 Drag “wait 1 sec” Block

4) Next, we need to let the LED keep off for 1 second. Right-click “set digital pin
P1 output HIGH"”, then click “Duplicate”.

Figure 2.2.9 “Duplicate” Blocks



Welcome to the DFRobot blog: https://www.dfrobot.com/blog-tag-microbit.ntml
30 / 115

Cool! Click the right mouse can duplicate
the blocks. It is very convenient!

()4
=

0

5) Place the duplicated blocks under the block “wait 1 sec”, change “"HIGH" to
“LOW" to let the LED keep off for 1 second. Since we used forever statement

here, the program of LED flashing will be running all the time.

(*~® micro:bit starts

(> setdigital pin P1~ output HIGH ~

(== setdigital pin P1~ output LOW -

Figure 2.2.10 Run the program

Result: the LED keeps flashing when the code is uploaded successfully.

7.Design of Cat

Gveeﬁe, | heard that you will go camping with your friends. |
am worrying you may get lost outside.

How about make one emergency device SOS?

Reminder: How to send emergency signal SOS via LEDs?
To send out SOS for help, we just need to flash LEDs according
to the rule 3 shorts, 3 longs and 3 shorts again.

3 longs are presented by ‘ON---OFF---ON---OFF---ON---OFF-
--' and 3 shorts are presented by 'ON-OFF-ON-OFF-ON-OFF- ‘.
Notice it? The time that 3longs costs are 3 times of 3shorts.

\Let's doif! /
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Project 3: Notification Light

1.Story of Cat and Micko

Mr. Micko, | will flying to DF

@ Starship with my friends this
\‘Q week, but | am a little afraid
& of dangers.

Eh, it will cost several hours at
plane. You guys should prepare
some emergency equipment.

(989 Yes, Mr. Micko, if the plane
A goes off course and we got
(k lost in the vast cosmos, what

should we do?

My dear, do not be frightened. Once
you have be noticed by other
spaceships, you will be safe.

Oh! We can make a notification light. Its
brightness can be adjusted from the maximum to
the minimum. If any dangers, we can adjust the
light to the maximum brightness. And others can
easily find us!

Mr. Micko, could you please help me make it? j

No problem! Let’s make
one notification light.
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2.Micko’ Pocket

vl

1 x micro: bit 1 x micro: bit Expansion Board
. -
o2r @ =

1 x LED Module 1x micro USB Cable

() [ )
i2r 3. i1C

1 x Push Button 1x Knob

//

Know something about Push-button and Switch Knob:

Push-button is the common button we can find on lamp. By programming, we

can realize to turn on/off the LED through the Push-button.
Switch the knob to different angles, we can control the brightness of the LED.
What's the differences between Push-button and Knob?

Both are input modules.

The electric circuit can only be connected when the Push Button is pressed.

range.

And the electric circuit can be connected when the Knob rotates within one V
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:l‘ Mr. Micko, is that Input inputs signals? ]

P
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-

So clever! You are right.

For an example, in the project LED control
via the Push Button, the Push Button is a
input and the LED is a output.

\_

3.Dream of Cat: Control LED by Push Button

| want to make a bedroom LED.

When | press the Push Button
the LED is ON, and when | loose

it, the LED is OFF.

4.Micko’s Blackboard
STEP1: Connect Push-button module to pin PO of the expansion board; connect

the LED to pin P1.

Figure 2.3.1 Connection Diagram
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STEP2: Programming

1) Click “micro: bit” module, find “read digital pin PO" block and drag it to

script areaq.
ﬁM‘r‘d+
SR>~ = k]
e
i’y = e
Variabes —
-
B
&
Y S o L
S o]
Figure 2.3.2 read digital pin PO block
0 0 Mr. Micko, why not use high level and low level at
— here?
Q2
g
&weeﬁe, because we need to check the PO value 10\
judge whether the Push Button is pressed.
When the Push Button is pressed, the digital value
read by Mind+ is 1, which means high level and the
LED is ON.
Well, when the Push Button is loosen, the digital value
read by mind+ is o, which means low level then the
LED is OFF. So it is certain to be used in the future, but
Qoi now.
2) The "="in the “"Operators” module can be used to judge if the push-

button is being pressed. If the value of “read digital pin PO is “1", the
button is pressed, otherwise, it is unpressed. Nest the block “read digital

pin PO" into the equation.
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ﬁm Project » Learning w Connect Device w

varaties ‘CIX P
®--0
®-@
—

micro:bit

@9 microbit starts

Figure 2.3.3 “=" Block

Mr. Micko, how to judge whether the Push
‘@ Button is pressed?

Good question! We can judge it by the
condition judgement command

“if...then...else”. But how? Go on reading

Cnd you will see.

3) Find “if then...else” block in the “Confrol” module, and drag it into the

“forever” block.

miﬁi} Project » Learning v Connect Device «

Blocks |
. Control
Control Yo
&® microbit starts
Operator: =
repeatm
Variables 7

My

Blocks

f =13 @9 read digital pin PO~ =
micro:bit]

Figure 2.3.4 “If then...else” Block
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4)

5)

Nest the conditions of equation into the “if then...else” block as shown

below:

ﬂm Project v leamning » Connect Device w»

G2 read digital pin PO~

:o then

My
Blocks
E13
microzbit

else

Figure 2.3.5 Nest Blocks

Find the block “set digital pin PO output LOW" in the “micro: bit"”
module. Revise the block into “set digital pin P1 output HIGH” and place
it under “if then” block. When the button is pressed, this command will
be executed and the LED will be on. Then place “set digital pin P1
output LOW" block under the “...else” block. When the button is

released, the LED will be off.

(*~) micro:bit starts

if (" read digital pin PO ~

(» setdigital pin P1~ output
else
(== setdigital pin P1~ output

Figure 2.3.6 Run the Program
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5.Dream of Cat: Control LED by Knob

Sometimes, the light is too bright.
Could | use the Rotation to control the

brightness?

6.Micko’s Blackboard

STEP1: Replace the push-button module in the last project with switch knob

module.

w

Figure 2.3.7 Connection Diagram
STEP2: Programming

1. Connect the switch knob to pin PO. Click “micro: bit" module and select

“read analog pin PO" block.

&M‘nch

Figure 2.3.8 “read analog pin PO" Block
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The brightness of LED is decided by the value of the analog pin (knob’s
angle). Switch the knob to control the LED's brightness. Micro: bit “read

analog pin” (knob) ranges from 0 to 1023, so does the output analog pin.

So, it's ok to read the analog pin PO directly! V

2. Drag “read analog pin PO" to the script areaq.

(% read acceleration x -~
(=® read magnetic force x ~ @9 microbit starts

@9 read digital pin PO -

(=9 read analog pin PO ~

(o setdigital pin PO~ outp

(=® read analog pin PO~

(®» setanalog pin PO~ outp

Figure 2.3.9 “read analog pin PO" Block

3. Drag “set analog pin PO output” block of “micro: bit” module into
“forever' block in script area, and change PO to P1. Nest the “sef analog

pin P1 output” block with the block “read analog pin PO”.

(*"®) micro:bit starts

(@» setanalogpin PO~ output (% read analog pin PO~

Figure 2.3.10 Run the Programs

We can understand the codes in this way: the value of the

position the knob switched is the brightnhess of the LED.
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7.Design of Cat

My dear, can you design a beautiful and practical

rotation light now?

0@0

>
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Project 4: Electric Fan

1.Story of Cat and Micko

Mr. Micko, DF Starship is so interesting! With

@ the inertia, we are floating in the outer
AN space. | have seen lights and shades from

the portholes.

Little friend, are you get
used to the spaceship
environment?

oL It's all right, except the high
2 temperature in the cabin. We
QK all felt very hot and wanted to
g have a fan.

J

Poor you guys. Do you
want to make one fan with
adjustable wind?

)
N Yes, yes! | will not worry about

hot weather if | have one. Mr.
Micko, please teach me!

Sure, let’s begin the class.
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2.Micko’ Pocket

vl

1 x micro: bit 1 x micro: bit Expansion Board

P

06 & —
di = .
1 x Fan Module 1x micro USB Cable
e o
2r & it C
- 1
1 x Push Button 1 x Knob

The fan is similar to household fan, inside of which has motors and

blades. The speed of the fan is adjustable.

3.Dream of Cat: Push-button Fan

| want a remote-control fan so
that | can sit at sofa and
conveniently turn the fan ON

and OFF.

00
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4.Micko’s Blackboard

STEP1: Connect the push-button module to pin PO of the expansion board;

connect the fan module to pin P1.

[ ———)
of &
i

wll

Figure 2.4.1 Connection Diagram

x©
Let's see how to use the fan module:

Connect micro: bit with computer, debug and download your programs.

In the experiment the power consumption of fan and servo is large, so
independent power supply (USB power supply) is necessary. Connect the

external power to the VIN port of the extension board.

N OFF

@ Cc*
PO

VIN I
N

Detect the pin value (0 or 1) to judge if the button is pressed. When it is

pressed (pin value=1), the pin connected to the fan is HIGH, and the fan
starts to work. When the button is released (pin value=0), the pi

connected to the fan is LOW, and the fan stops rotating.
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STEP2: Programming

1. Click “micro: bit” module, select “read digital pin PO, and drag it to

script section.

@Mﬁiﬁk} Project » Learning » Connect Device w

Blocks ‘
. (® read ambient brightness
Control

® @9 read compass orientation
Operator: (GDEEEL RSN T
@9 read acceleration x =
es
@9 read magnetic force x =~
My

igi A @9 read digital pin PO~
PSR C© read digital pin PO -

——
i (+® read analog pin PO~

Figure 2.4.2 “read digital pin”

@® microbit starts

forever

2. The "="in the "Operatfors” module can be used to judge whether the
button is pressed. If the value of “read digital pin PO™ is “1", which
suggests the button is pressed, otherwise, it is released. Nest the block

“read digital pin PO" intfo the equation.

:

Project v Learning + Connect Device «

Blocks |
@ G XKL
@ v
S [o o3
. 2 micro:bit starts
Variables €_Jdh J
forever
e
My
plocks NP
¢ &
microbit €SP e ) - @
length
—_—

Figure 2.4.3 “="

3. Find “if then...else” block in the “Confrol” module, and drag it into the

“forever” block.

ﬂm Project » Learning » Connect Device =

Blocks ‘

. Control

Operator: (oY

> G microbit starts

Figure 2.4.4 "If then...else”
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4. Nest the conditions of equation into the “if then...else” block as shown

below.

(*® micro:bit starts

if (® read digital pin PO~ = o then

Figure 2.4.5 Nest Blocks

5. Find the block “set digital pin PO output LOW" in the “micro: bit” module.
Revise the block into “set digital pin P1 output HIGH” and place it under
“if then” block. When the button is pressed, this command will be

executed and the fan starts to rotate. Otherwise, the fan stops rotating.

(*"® micro:bit starts

if (¢ read digital pin PO~

(=» setdigital pin P1~ output
else

(=% setdigital pin P1~ output

Figure 2.4.6 Run the program

Mr. Micko, this program is similar to the
former Notification Light.

How observant you are! Yes, the principle to control a
fan is as soma as to control a LED.

It is so great that you can think and consider.

Keep this good habit!
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5.Dream of Cat: Set the fan running at different speed

The Push Button fan blows too fast,

| want to control the rotating
speed. Can | make the fan running

at different speed?

§ OOO

6.Micko’s Blackboard

STEP1: Replace the push-button module in the button-fan project with switch

knob module.

wn

Figure 2.4.7 Connection Diagram
STEP2: Programming

1. Click “micro: bit”, drag “read analog pin PO” block to script section
@Mind+

]

Control @3 PO~ pinis connected?

. @9 current state is logo up

Operator:
@ read ambient brightness @9 micro:bit starts
APl G 9 read compass orientation
. (9 read temperature

My
Blocks

1

(9 read acceleration x ~

ff (@ read magnetic force x »

@ rtsguapo -

9 read analog pin PO =

micro:bit

@® setdigital pin PO~ outp)

Figure 2.4.8 Read analog pin PO
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2. Drag the “set analog pin PO output” of the micro: bit module to the
“forever” in the script areq, revise PO to P1, and nest the two blocks as

shown below.

(¢ micro:bit starts

(9 setanalogpin P1~- output (¢ read analogpin PO~

Figure 2.4.10 Run the Program

(989 Mr. Micko, why we can read the rotate
@" value directly?

Dear, because the output range of fan is the
same as the input of knob. Both are 0~1023.

@ Mr. Micko, what happened to different
W range?

Well, if the range is different, then we need
to use a new command map:

map @) from[ @ . ED) 1t0[ @ . ED
g

: , So if we map the input range to the output
range, it will self-correspond?

[ Smart! You are right. i:
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7.Design of Cat

The summer is coming, do you want to make a cool fan
lamp? Then you can enjoy the cold wind more comfortable.
Tip: How to use 1 micro: bit to control LED and fan at the

same time?

\_

0
)
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Chapter 3: Get hands on!

Except the push-button and switch knob module we learned before, there are more
commonly-used sensors. Use them to make more smarter, funnier and useful projects.

Come and learn!

Project 1: Electronic Candle

1.Story of Cat and Micko

Mr. Micko, it's been a long time. We are
A back from the DF spaceship.
S

How's the traveling? Have you enjoyed B
yourself?

AN

Yes, a nice trip. Here is a TV in the DF spaceship

' and | watched a video about greenhouse
(939
= effect, and the main cause is greenhouse gas.
\(‘ D So seriously. From the news | know any human

activity may emits greenhouse gas, such as
making a fire, driving car, air-conditioner.

You are right, we should try our best to protect
nature, and reduce the greenhouse gas emission.

Mr. Micko, | will attend a birthday party of my
QK X best friend. What kind of gift should | give her?
S

How about an electronic candle? An electronic ?

candle will not pollute the environment.
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2.Micko’ Pocket

v [l

1 X micro: bit 1 x micro: bit Expansion Board

o2r @ iq .%

1 x LED Module 1 x Sound Sensor 1 x micro USB Cable

Sound sensor can sense the intensity of sound. After programming, it can

Let's get to know about sound sensor:

be used to turn on/off the LED through the sound infensity.

4

3.Dream of Cat: Detect the sound strength

I want o know my voice
power. That is to say, if the
micro: bit shows 1 on board,
means low voice; if it shows 2
means high voice.

50 Nel®)
&
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& How to design the project?

hen the analog value of sound intensity is less than 80, we set the on-board
LED display the figure “1", which means that the sound is low and intensity is

grade 1.

Elsewise, when the analog value is over 80, the on-board LED display figure “2",

which means the sound intensity is grade 2. V

4.Micko’s Blackboard

STEP1: Connect the sound sensor module to the pin PO of the extension board;

LED module to P1.

s Q

a2r @)

oo IR

VIN I

Figure 3.1.1 Connection Diagram

STEP2: Programming
1. Let's begin to design our project according to the tips: drag “read analog
pin PO" and “display” blocks from the “Micro: bit” module; drag out “if...
then...else” block from the “Control” module; drag “<" in the “Operation”

module to script area.

,)Le’r’ s review “if...then...else” statement: - .

The function of “if...then...else"” statement:

If condition is frue, the statements following “then”
are executed. If condition is false, the statements
following “else” are executed.
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® O
Operator! m
o ®

Figure 3.1.2 “if...then...else” Figure 3.1.3 “<”
2. Read the analog value(0~1023) of “read analog pin PO” that connected

with sound sensor to detect the sound of intensity.

3. Edit the programs to realize “sound intensity detecting”. “<" can be used

to judge if the analog value of sound intensity meets the set standard.

AS shown in figure 3.1.4, if the condition “'read analog pin PO'<'80"" is frue, also

means the sound intensity grade is 1, the on-board LED displays figure “1".

If the condition is false, the sound intensity grades 2 and the LED displays figure”2".

Add a “wait 1 sec” block under the “...then” to prevent the LED figure from

flashing.
o © g @
_ display @) ‘
@ display @ ‘
Figure3.1.4 Run the Program
()3 . .
= Mr. Micko, this program really can test my
\(Q voice power!
N

Well donel! If it always shows 2, suggesting the
environment is a little noisy. And the value 80 is too
low. So, you should try setting a larger number.
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5.Dream of Cat: micro: bit Candle

Can | make the micro: bit a
candle? When | do not blow, it
keeps ON, and when | blow
the LED is OFF.

6.Micko’s Blackboard
Control the LED to turn on/off according to the value of the pin connected to

the sound sensor. *

-

Let me explain the principle of this electronical candle.

When we don’t blow, the voice cannot reach the lowest
strength, the LED is ON and the LED Pin is high level; And
when we blow, the voice reaches the lowest strength.
The LED is OFF and the LED Pin is low level.

\_

1. Drag “set digital pin PO output” block from “micro: bit” module to script

area, and change PO to P1.

. (@ current state is logoup~ 7

Control
M < rcad ambient brightness

MY read analog pin PO -

I set digital pin PO~ output LOW ~
@® setanalog pin PO~ outdt @B

Figure 3.1.5 “set digital pin output”
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2. Programming to make a “electronic candle”
When the analog value of sound sensor is less than the preset value 80, the LED
keeps on, otherwise, blow it like a candle, when the sound intensity is over 80,

the LED keeps off for 2 seconds.

(* "= micro:bit starts

if ¢® read analogpin PO~ < @ then

(=» setdigital pin P1~ output HIGH ~
else
(=% setdigital pin P1~ output LOW ~

Figure 3.1.6 Run the Program

7.Creation of Cat

Doll, you can share this green and funny e-candle with
your friends. Besides birthday candle, can you make
more DIY by this packet code?

Why not show me your ideas!

\_

My Design | My Program

(98
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Project 2: Automatic Door

1.Story of Cat and Micko

Mr. Micko, it is so funny to make that e-
candle last week. There are so many
interesting gismos in our life.

Yes, my dear, it's not the lack of joys in life,
but the lack of the eyes to find joys. Have
you find any joys?

Well, Mr. Micko, | went to library bor%
robot-making book last week and found that

I need not open and close the door. It seems
like the door can feel my actions.

\ / iO
s

Sweetie, | am so pride of you! You are a little
observer now. Guess why you need not to
open and close the door?

Em, maybe someone find we will go and
open the door. But when | came in, | found
no one.

the door. The device can control the door

Ha-ha, my dear, there is a magic device in
and make the door open and close.
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2.Micko’ Pocket

vl

1 x micro: bit 1 x micro: bit Expansion Board
()
iEr.& | =

1 x Push Button 1x micro USB Cable

<<}1 ;%» ~

1 x Motion Sensor 1x Servo

First time to see Motion sensor and servo module, let's take a look:

Motion sensor, also called PIR sensor, can detect the infrared signals

from human body or other animals and triggers with movement.

A servo come with a shaft that can be positioned to specific angular (0-

180°/0-360°). Compared with motor, it has smaller rotation speed but

larger torque. They are extremely useful in robofics. V
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3.Dream of Cat: Control Servo with Push Button

| want to use the Push Button to
control the servo, press the
button and the servo rotates
100°. Release the button, the
servo rotates 0°.

4.Micko’s Blackboard

STEP1: Connect push-button module to pin PO of the expansion board; connect
servo to P1.

il

Figure 3.2.1 Connection Diagram

g

/‘

Add a command module before programming:

If we want to control the servo, we have to add the servo mand

module. How to do thate

Click Extensions->Actuator->Micro Servo, and then back to the

f

former interface.
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F

Kit Board Sensor ommunication Display

[ Bl G5 when received wireless data

Can't find what you want, click he

My
MY <5 rcceive data from wireless
E=i3
IR <o serialin suing > EIY Wrap -
@3 Is there data to read on serial port? Q
&

IoFr0299} M [sEr0006) DFR0523
|ser0006

@2 read serial data
ihamad
@® set serial-port baud rate tq, 9600 ~ Mp3 Module Micro Servo Peristaltic Pump
Mp3 Player Module Micro Servo Peristaltic Pump can delivery
fluid by squeezing and

=
-— GCEETTD
system uptime
releasing the pump

Figure 3.2.2 Extensions Figure 3.2.3 Actuator->Micro Servo

STEP2: Programming
Drag “set pin P9 servo to...degree” block in "actuator” module. Change P9

1.
to PO. Set pin PO to control servo’ s value.

Blocks ‘

== send string via wireless

. (#® when received wireless data
Operator:

Variabl

(9 receive data from wireless

es

0

= serial in string ~ m Wrap -

(@ Is there data to read on serial port?
Blocks

&
USSRl o) set serial-port baud rate to 9600 «

e (aD)} tem uptime
sys p
Actuator

(=9 read serial data

Figure 3.2.4 “set pin PO servo to...degree”

oyt Mr. Micko, is that control the servo value is to
@ control the degree?

Yes, you can control the rotate degree by
input the servo degree.
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2. Set: if the button is pressed, the servo rotates for 100 degree and the LED
display “o”. Otherwise, the servo rotates for 0 degree and the LED display
“x".Here we need to use “if...then...else” statement.

W
My
Blocks

Figure 3.2.5 “if...then...else”

Note: an external power supply is necessary since the power

consumption of the servo is large.

If you forgot how to connect the external power, review it at the

%

"Control the fan with Push Button”

3. Run the program

("9 micro:bit starts

forever
if @9 read digital pin PO~ =) then
L,@V set pin P1~ servoto degree

» display pattern
else

(@7 setpin P1+« servoto {{i) degree

(9 display pattemn

Figure 3.2.6 Run the Program

Mr. Micko, this is exactly what | want! But |
forgot to connect the power supply and
worried that the servo maybe broken.

That's Ok, we need to be patient and careful
durina testina the nroaram.
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Result

Figure 3.2.7 Result-Loosen Figure 3.2.8 Result-pressed

5.Dream of Cat: Control the Servo with Motion Sensor

| want to make a mini control
device of automagical door.
The servo rotates 100° if
someone passed, otherwise
rotates 0°.

\% 00O

6.Micko’s Blackboard

STEP1: Connect the servo to pin P1; connect the motion sensor to pin PO.

A
24
i13f)

a1 [

Figure 3.2.9 Connection Diagram
STEP2: Programming

1. Read the digital pin PO to get the digital signal data of the motion sensor.



Welcome to the DFRobot blog: https://www.dfrobot.com/blog-tag-microbit.ntml
61 / 115

[ Diflgéls Project = Leaming v Connect Device +

Control G2 A~ button is pressed?
® @D PO- pin is connected?
R > curent state is logoup - 7 @9 microcbit starts
forever
. @2 read ambient brightness
Variables
P @3 read compass orientation
o
Blacks
-

e o read magnetic force x -

@3 read digital pin PO~

@9 read analog pin PO -

9 setdigital pin PO~ outpht LOW -

E
L
£

Figure 3.2.10 “read digital pin”
2. When the motion sensor detected that there is people passing by, the
servo rotates for 100 degrees; otherwise, it rotates 0 degree. We need
“if...then...else” statement here.

o
My
Blocks

&8

Microbit

repeat until

Figure 3.2.11 "if...then...else”

3. Run the program:

(*"® micro:bit starts

if @3 read digital pin PO~ =@ _then

/& setpin P1+ senoto degree

@» display pattem
else

{@7 setpin P1+ servoto ({iJ) degree

(> display pattem

Figure 3.2.12 Run the Program
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Result

Unoccupied Occupied

Figure 3.2.13 No one passed by  Figure 3.2.14 When people passed by

7.Creation of Cat

oS What a magic device! | know the way to
@ control a door now.

NC®,

Yes, my little friend, do you remember what |
mentioned above? With micro: bit and
mind+, you can make, enjoy and learn.

o8 Mr. Micko, besides automagical door control,
o @ can we make other gizmos?
v,

oY
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Project 3: Music Box

1.Story of Cat and Micko

A Mr. Micko, except robot class, do you know
which class is my favorite?

\(Q
S

Let me guess, probably music? The beautiful and
lovely sounds are always attractive.

B
& Bingo! Music is one of my favorite classes.
QX .
o Last week, our music teacher showed us

a beautiful box and that box can play
music. My goodness, | want to have one.
\ -

/
7

[ Why not take the micro: bit and make one?

2.Micko’ Pocket

v [l

1 x micro: bit 1 x micro: bit Expansion Board
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N
1 x Earphone 1 x Motion Sensor 1 x micro USB Cable

3.Dream of Cat: Play Music

My wish is to make
micro: bit play music!

8

4.Micko’s Blackboard

00

STEP1: connect micro: bit board to computer with USB cable, plug the earphone

in the expansion board; connect the motion sensor to pin P1 of the expansion

board.

-

communication, so it cannot be used when playing sounds.

Note: pin PO has been occupied by the earphone jack data

w

Figure 3.3.1 Connection Diagram
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STEP2: Programming

1. Drag “pin PO play sound...until done” block from “micro: bit" module to
script area. There are many built-in sounds o choose. We select the sound
“dadadadum” here.

e P e

Blocks
. (@9 show~ coordinatesofpoint (x 0~ ,y: 0~ )

I}
o
El
=
o

(@® setbrightness 9~

Operator: aDELLEEI S

Variabl

sl G5 pin PO~ playsound DADADADUM -

My (=9 pin PO~ playsound DADADADUM - until done
Blocks

&
micro:bit @® change tempo (bpm) by

@9 pin PO~ playnolefor 1~ beat

@9 settempo (I)pm)tn@
@ stop background playback

@9 tempo (bpm)

Figure 3.3.2 Command “pin PO play sound...until done”

2. Run the program

(* 9 micro:bit starts

&9 pin PO~ playsound DADADADUM + until done

Figure 3.3.3 Run the program

How amazing! This small board can even

& play music!
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Ha-ha, this is just a tip of the iceberg.

You will find more interesting functions.

5.Dream of Cat: Smart Music Box

I will play my own music in
micro: bit. How cool if it can
play when | am moving close
and stop playing when | am
leaving.

(DAY

.?" OOO

6.Micko’s Blackboard

. Program to generate a piece of music of Twinkle, Twinkle, Little Star.

0 ® Mr. Micko, | love music but | am not good at it. |
Q . know nothing abut musical note. What should | do?

My sweetie, do not be so nervous. Come look
at the Little Tips!

Micko

Let's take a look about the numeric notation tablature of this song.
The different key and note decided the different frequency of the

sound.
Twinkle, twinkle, little star
- - - ¥ o
[a=c|lt 1 s 5 6 6 5s— 4 4 3 3 2 2
key Signature Twin-kle twin-Kle lit-tle star, how | won-der whatyou are! Note

How to use Mind+ to present the numeric notation tablature and
play the sound

Note 1 2 3 4 5 6 7

(do) (re) (mi) (fa) (sol) (la) (si)

Letter C D E F G A B
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2. Drag “pin PO play note-C2 for 1beat” from the “micro: bit” module to script
areq. Revise the parameter “C2” to play different notes, and change the

parameter "1"” to adjust the beat.

(% stop animation

| i

Control

(= micro:bit starts

. (== show~ coordinatesof point (xx 0« ,y: 0~ ) forever
Operator: [aD) play notefor 1~ beat
(=% setbrightness 9~
QD) play note QEeJUf@j&) for 1 - beat
Variables ] !
@9 hide all dot matrix [aD) play note EeJUg¢f{cE) for 1~ beat
M. @9 pi play note for 1+ beat
Y :
ISl G © pin PO~ playsound DADADADUM » [aD) play note for 1+ beat
:: =% pin PO~ playsound DADADADUM ~ until done (o FEFrTiE( Low /A3 )i (gl
micro:bit = @ pi play note {ESNREN{eE) for 1~ beat
=» pin PO~ play note m for 1~ beat
H [T " H .
Figure 3.3.5 “pin PO play note Figure 3.3.6 Write the Song

But Mr. Micko, how could we make micro: bit
play music when moving close and stop
playing when leaving.

0@:

Sweetie, writing The Twinkle Start to micro:
bit and it can sing!

(

Well, do you still remember the automatic
door? The principle of automatic music play
is the same as that door. What we need is just
a sport sensor.

G

3. Motion sensor has been connected to pin P1, if someone passes near the
device, the value of P1 will be 1, otherwise, it will be 0. Therefore,

combining it a “if then...else” statement, we can make the smart music

box come to life.
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&= micro:bit starts

&= read digital pin P1 - = @ then
play note {EllffoViec]y for 1 -~
(LG Tl L ow C/C3 Bisld
(BTl | ow G/G3 ield
play note for
play note @EINLVIEY for

[1EVR Tl Low A/AS Biels

[CD)
(o)
0=
(===)
===]
===)
(a0

[IEVE Tl Low G/G3 Bield

Figure 3.3.7 Run the Program

7.Creation of Cat

My friend, do you what to make your own music box? Get thinking
and making one!

My Design| My Program

< @:

>
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1.Story of Cat and Micko

Mr. Micko, the last music box is so cool!
But...

Yes? Any questions?

Mr. Micko, | want to make a good-look%
shell. How fantastic if the shell can shining

like stars and dancing with the music.

| see, sounds not bad. You know? micro: bit B

can achieve it!
J

~
Wow! Really?! micro: bit is so powerfull Mr.

Micko, please help me make it!

J

[ My pleasure. }
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2.Micko’ Pocket

1 x micro: bit 1 x micro: bit Expansion Board

| —

i9 O N -

1 | ﬁ
L

1x Sound Sensor 1x Colorful LED Strip 1 x micro USB Cable

First time to see LED strip, come to meet her:

We can set different parameter to each LED of the LED strip fo

achieve all kinds of cool effects. 7

3.Dream of Cat: Turn on the RGB LED strip

This time, | want to light ON
all LEDs and makes them
shine like a rainbow!!

(9

=
2z 000
L °
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4.Micko’s Blackboard

STEP1: Connect the LED strip to pin PO of the expansion board.

LR
G
Fo '\"INI

Figure 3.4.1 Connection Diagram

STEP2: Add the LED strip command module. Click Expansions->Display->WS$2812
RGB LED Strip, then back to the former interface.

OLED-2864 Display I WS2812 RGB LED Strip I LCD1602 Display Digital LED Light Module

MAX7219 8x8 dot matrix 8x16 RGB LED dot matrix (

Figure 3.4.3 Add the display “WS2812 RGB LED Strip”
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STEP3: Programming

1. Click “display” module in the left to present the LED strip commands.

O display

Control 7ii pin P2~ @ RGBlights Brightness €
[eLOEICRE 73§ pin P2~ LEDs brightness

in P2~ clear
Variables 7Tl P

. 77 pin P2~ @ to @ Leds show color
My
B Cll 771 pin P2~ red green blue €&
&

micro:bit

=
display

771 pin P2~ @ to @ Leds show gradient color hue: @@ to

77§ pin P2~ shift pixels by @

Tit pin P2~ shift pixels cyclically by o

777 pin P2~ (@ to @ Leds show histogram current value: (@) max value: @)

Figure 3.4.4 “WS2812 RGB LED Strip” blocks

L) There are so many blocks at here. | feel a little
@ dizzy.

Take a breath! Come look at the Little Tip and
check the commands one by one.

How to use the commonly used LED sirip commands?

To start using the LED strip, we need to select the pin that the LED strip

connected to micro: bit, and set up the LED numbers and color modes.

1. If you want to set how many LEDs will be used and what brightness

they will display, the block is shown below:

77§ pin P2~ @D RGB lights Brightness

(the highest brightness is 255; the LED number is the total number of LEDs
that physically included in the strip)

2. If you want to set light effect, you need to use the following block:

TT§ pin P2~ o to o Leds show gradient color hue: o to

(LED 0 represents the first LED, and there are 360 colors.)
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Z Mr. Micko, why 0 stands for 1 LED? Why we do
not use 1 to represent 1 LED?
\

Big question! This is because the Arabic
numerals are beginning with 0. So we
always use 0 as the first one, so the 1 LED
is represented by 0.

2. The pin PO connected to the LED strip comes with 7 LEDs. Set the color

range to 01-360 to realize a rainbow effect display (red-green-blue).

(*® micro:bit starts

7it pin PO~ a RGB lights Brightness @
715 pin P2+ (@ to @@ Leds show gradient color hue: @) to

Figure 3.4.5 Run the Program

I guess the LED belt has 7 LEDs. Counts the LEDs
from 0 to 6: 0,1,2,3,4,5,6. There are 7 numbers
= at all. So the LED number is from 0 to 6.
\(Q
&

Result

Figure 3.4.6 Result
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5.Dream of Cat: Turn on the rainbow LEDs

Can we light ON 1 LED in
every second?

P

6.Micko’s Blackboard

00O

Sweetie, the way to realize this effect is a
little harder. You need to think more and be
more patient. Fighting!

1. If we want to make the LEDs turn on in a sequence, we need to use a new

module; Variables.

:l‘ Mr. Micko, why should we use variables? ]

Dear, if you want the LED flash one by one.
You need to judge the LED quantity first. If the
LEDs are more than 7, you need to use the
variable to loop again.

>
‘é{: ﬁ | see, | see. ]

To set such a variable, go to: “Variables-> Make a Numeric Variable”, and set

the name of the variable (to be clear, we named the variable as “the number

of LEDs to be lit"). Then click OK.
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['Pilidls, Proiect v Leaming w Connect Device v

. Variables

.
New Variable
Control | Make a Numeric Variable

® New variable name:
h My Blocks

mi

i
Blocks

& @D microbit starts

Rl -5 when button A - pres

Figure 3.4.7 Create a new Variable Figure 3.4.8 Name the Variable

é First time to create a variable, let's get o know:

After we created the variable, the blocks of “the name of the variable”,

Make a Block
icro:bit

“set...to” and “change...by” will appear in the command section:

Blocks ‘

. Variables
Control " Make a Numeric Variable

. the number of LEDs to be lit
Operator!

set the number of LEDs to be lit + to o
Variables] ‘ cgnge the number of LEDs to be lit + by o
. Make a Character Variable
My B
Blocks Make a List
35 My Blocks

micro:bit Make a Block

Just drag the related block to the script when you need it!

2. Initialize the pin and total number of the LED, and set the brightness. The
initial value of the variable “the number of LEDs to be lit” ( o for short)

should be set to O(since all the LEDs are turned off at first).

(*_¢ micro:bit starts

71§ pin PO~ a RGB lights Brighiness
set the number of LEDs to be lit~ to o

Figure 3.4.9 Initialize the pin and total number of LEDs

3. When o <6, a LEDs to be lit, then maintain 1 second, and make the

parameter getting larger by 1 in every loop. If « >6, make all the LEDs turn
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off and start from the beginning. The flow chart below may help us to

figure out what the program looks like:

Start

. J
Set the value of “the number of LEDs
to be Iit" (a) as 0

—_— a<=6

YES

a LEDS to be lit

“the number of LEDs
tobe lit” (c)=a+1

L

Figure 3.4.10 Flow Chart

Sweetie, it is worth thinking about the flow chart. ?

i Mr. Micko, thinking with a flow chart is so clear!

oLe
3
oL

[ Sure! You can try draw a flow chart later. ?

4. Programming according to the flow chart, first setting the conditions, we

need to use “if...then...else” and “forever” blocks.

(&% microzbit starts

Til pin PO~ a RGB lights Brightness
set the number of LEDs tobe lit~ to @

the number of LEDs to be lit <= e

a

Figure 3.4.11 “if...then...else” and “forever”
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5. If “the number of LEDs to be lit"(« ) is less than 6, light up « LEDs, wait 1
second, then make the parameter getting larger by 1, which means to
make one more LED light up.

(*® micro:bit starts

77§ pin Po- (@ RGBlights Brightness
set the number of LEDsto be lit» to 0

if the number of LEDs to be lit <= @@ _then

7i% pin PO~ o to ( the number of LEDs to be lit | Leds show gradient color hue: o to

set the number of LEDsto be lit+ to the number of LEDs to be lit + o

Figure 3.4.12 Commands about «

6. When the number of LEDs to be lit is over 6, set the value of “the number

of LEDs to be lit” to 0, and turn off all the LEDs.

(9 micro:bit starts

Tit pin PO~ o RGB lights Brightness
set the number of LEDs to be lit = to o

set the number of LEDs to be lit + to the number of LEDs to be lit + o
set the number of LEDs to be lit ~ to o
T4 pin PO~ clear

Figure 3.4.13 Run the Program

Mr. Micko, the program looks a little complex.

\

Yes? Although the programs become more
and more complex, the works will be more
interesting. Practice makes perfect.

Get thinking now!

&
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7.Dream of Cat: RGB LED strip controlled by a sound sensor

Huh? Can we light ON only 1
LED when make sound?
When all 7 LEDs are lighted,
light OFF all LEDs and repeat
light ON one by on again?

(999

&
&% o0 O
R
8. Micko’s Blackboard

STEP1: The LED strip still connected to PO; connect the sound sensor to pin P1.

Figure 3.4.14 Connection Diagram

Mr. Micko, we have used the sound sensor in

(D4
N
\(‘Q the electronic candle!

Smart guy! You are right, the sound sensor
used at here was also used in the Page 50.
We will also use read analog pin in the
micro: bit.

STEP2: Click “micro: bit” module, drag the “read analog pin PO” block to script

area, and revise PO to P1.
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Project -+ Learning - Connect device

= A~ button is pressed?

@
)
x

[

I

<
v
3
B
g
1
n -

Il
Q
3
3
2
e

== PO~ pinisconnected?

0
T
0
3
o
b
o]
3

= current state is logoup -~ 7
G o read ambient brightness = e g —

G = read compass orientation forever

g
<

& 2 read temperature

g
0
n
=
in

& 2 read acceleration x -

o read magnetic force x - Il i

= read digital pin PO ~

3
i:89
g

display

&= read analog pin PO -~

&= setdigital pin PO -~ output LOW -

Figure 3.4.15 “read analog pin PO”

STEP3: If the sound value the sensor detected exceeds 40 and the “the number
of LEDs to be lit" «is less than 6, control the LED strip to light up « LEDs. Then the

sensor will be constantly detecting the sound value.

l

Set the value of “the number of LEDs

to be lit” (o) as 0 <

Sound intensity >40

l YES

| « LEDS to be lit |

|

| Maintain 1 seconds

[

“the number of LEDs
to be lit” (a)=a+1

I

Figure 3.4.16 Flow Chart

Mr. Micko, we have used the sound sensor in
the electronic candle!

o@:

Smart guy! You are right, the sound sensor
used at here is the same as what used in the
Page 47. We will also use read analog pin in
the micro: bit.
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STEP4: Programming

Based on the program of the last project, we need to add a “if...then” statement
to judge the sound value. That is o say, when “the number of LEDs to be lit" o <
6, if the analog pin P1 is over 40, then « LEDs will be turned on, wait 1 second,
change o by 1, and repeatedly to detect if the sound value exceeds 40. When
“the number of LEDs to be lit” a >6, all the LEDs will be turned off and start the

program from the beginning.

(9 micro:bit starts

774 pin PO~ (@ RGE lights Brightness
set the number of LEDs to be lit « too

if the number of LEDs to be lit <=6 then
if @ read analogpin P1~ >= @)  then

7it pin Po~ (@ to (the number of LEDs to be lit) Leds show gradient color hue: @ to

wait o seconds

set the number of LEDs to be lit~ to the number of LEDs tobe lit + (]

else
set the number of LEDs to be lit « too

77§ pin PO~ clear

Figure 3.4.17 Run the Programs

9.Creation of Cat

Wow! Such a difficult program! Seems like | need to
practice now. How about make a funny sound
control light? Come to join me!

QMo
>,

< @:
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Chapter 4. Become an expert

We have built so many funny works with different types of modules in previous
chapters. You may now have a deeper understanding of the micro: bit. Is that
enough for the exploration? The answer is doubtlessly NO! Hang on there and

we will take another further step into the micro: bit.
Project 1: Electronic Stabilizer

1.Story of Cat and Micko

Mr. Micko, | found an amazing
N> phenomenon when playing outside.
S

[ What's that?

~

_ Mr. Micko, my telephone was lying in my

hand. But when my hand turns to left, the

N telephone page magically turns to right!
S

Could you please tell me why?

J

-

You are good at observing. That's because the self-
balancing device in the telephone. We call this
device stabilizer. The display pages should keep
upright so that we can conveniently check it. So the
telephone is set to know direction. And if you turn the

Ktelephone to left, the display page will turn to right.

@. Amazing! Mr. Micko, can we make a

@ e-stabilizer like that?
=\

Of course! Let's explore the magic electronic
stabilizer with micro: bit!
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2.Micko’ Pocket

1 x micro: bit 1 x micro: bit Expansion Board

1 x Servo 1 x micro USB Cable

3.Dream of Cat

How could | make a servo
pointer keeps vertical no
matter how to rotate?

00O

My sweetie, have you heard the
acceleration gravity?

Yes, Mr. Micko. | have heard the acceleration

U
®Q1_'7 gravity in Physics. But is there any connection
QE between stabilizer?

If you understand the acceleration gravity,
you can understand the principle of self-
balancing device more easily. Let’'s come
to the Little Tips to check it!
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&) What is gravity?

It is the force that attracts an object toward the center of the earth, or toward any

other physical object having mass.
What is acceleration of gravity?

The magnitude of the acceleration due to gravity, denoted with a lower-case g,

is 2.8 m/s2
What can we make using acceleration of gravity?

Micro: bit comes with an accelerometer, which can detect the gesture of the

micro: bit board automatically. Through the detection of accelerator and

programming design, we can realize to make an on-board servo keep pointin

upright regardless how we tile the board.

Mr. Micko, will we connect the servo to

& board and control the servo direction by the
\(‘t acceleration gravity sensor in the board?

Yes, you have understood it. But the
acceleration gravity has different directions.
Let's turn to the lLiitle Tips to learn which

@ direction we will use.

/I\ﬂcro: bit Accelerometer:

Micro: bit can detect the gravitational force along X, Y and Z
directions, whereas X is along the left-right direction, Y is along the
front-back direction, Z is perpendicular to the board and along the up-

down direction. Show as below:

=

+X

.
bt 8

Figure 4.1.1 X, Y, and Z axes  Figure 4.1.2 Value Changing
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T

<& When the micro: bit board lays flat on the desktop, gravitational force

goes along up-and-down direction (Z axis), so that the values of X and Y are

close to zero.

When we tilt the board, the value of X axis changes. When it leans to the

left, its value is negative, conversely, positive. Shown as figure 4.1.2. V

Mr. Micko, in my wishes, we need to
NS calculate the acceleration gravity in the
(k direction x?

[ Bingo! Good answer. T

STEP1: Connect the servo to the pin PO of micro: bit expansion board.

4.Micko’s Blackboard

Aedl

Figure 4.1.3 Connection Diagram
STEP2: Programming

1. Drag the “read acceleration” block in micro: bit module to script area. It

can be used to get the acceleration of X, Y and Z axes.

& Select X, Y and Z axis in the drop- J
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Project v Leaming w Connect device v

Blocks

. (=» stop background playback
Control
[ WL > tempo (bpm) &3 microbit starts

Operator: forever

® @9 A~ button is pressed?
REELLER" ) PO~ pin is connected?

My
IS G read ambient brightness
3:' @ read compass orientation

micro:bit
(@ read temperature

(@9 read acceleration x -

Figure 4.1.4 “read acceleration”

2. The output value of the accelerometer ranges between -1023 and 1023, and

we can use “display” block to check it.

(&® micro:bit starts

(= display % read acceleration x~

Figure 4.1.5 “display” the acceleration value

Figure 4.1.6 Result
3. When micro: bit board is titled to the left, a negative output value will be
produced along the X direction, so we need the servo to rotate toward right

to compensate this angle.

Mr. Micko, is there any connection between the
acceleration gravity and servo rotate angle?

&

QED

Little friend, such a good question. Continue
reading the chapters below.
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Here we have to use “map” function. Mapping the value of accelerometer’s X

axis (-1023~1023) onto the degree that the servo rotates (0~180 degree). After

mapping, when the board lays flat on the desktop, the angle of the servo will be

90 degrees. The corresponding relations show as Table 4.1.1

micro: bit

-1023 0 1023
accelerometer

Find “map...from...to..."” block in “Operators” module.

m{} Project v Leamning v Connect device
Blocks |
.7‘ Ricea
control KD
. m &9 microbit starts
Operator:

rt stril =P to Int - s .

© display © read acceleraion x -

VEUEDLIESE convert number o to ASCll
. convert string o to ASCII

convert number EE) to string]}

Blocks

E=1 3l [ map @ from @ . @D 10l @ . €D )

el constrain ) between(min) @) and(max)

Figure 4.1.7 “map” block

4. Click Expansions->Actuator->Micro Servo and back to the former interface.

Blocks ‘

Control @ = when received wireless data
. E® receive data from wireless
. @9 serial in string - @EE) Wrap -
=2 Is there data to read on serial port?

& read serial data

set serial-port baud rate to 9600 ~

IV GHTl G © system uptime

7
f = 3 actuator

actuator

57 setpin P9~ servo to ) degree

Figure 4.1.8 Servo Module
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5. Drag “sef pin servo fo... degree” block to script area, and put it inside the

“forever” block, then nest the “map..." block into it. Shown as below:

(9 micro:bit starts

setpin PO~ servoto (map (% read acceleration x~- from[ GIEE) . @EE) 1ol @) . €ED) 1 degree

Figure 4.1.9 Run the Programs

6. Fix the servo onto the expansion board with double-side adhesive tape so

that they both remain relatively still.

Figure 4.1.11 Keep Still Figure 4.1.12 Tilt to left

5.Invention of Cat

Mr. Micko, | can’'t believe my eyes, the self-balancing
device is so amazing! | found a Compass module in
Mind+. Would micro: bit can be a compass?

J

Yes, sweetie, now you can try using the electronic
compass in micro: bit and make one compass!
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>
%
<02

o The servo of micro: bit ranges from 0~180° , while the compass need to

rotate from 0~360°, so we can directly use “display” and “read compass

orientation” to get the position. Read the operation instruction of micro: bit

LED panel, then you can make it!

J

) @:

’
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Project 2: DJ panel

1.Story of Cat and Micko

Christmas is coming, what kind of program
will you perform?

& Mr. Micko, | want to play a new trick this\
A& year. | want to be a DJ and present

dynamic music with colorful lights.

Sounds good, | guess you must need one DJ
bandstand.

Yes! And | want to make one. Mr. Micko.
Could you please help me make it?

Of course, | am so glad to lend you a hand.

L) <
@ Wonderfull Time is flying, let’s begin the work.
NCW,




Welcome to the DFRobot blog: https://www.dfrobot.com/blog-tag-microbit.ntml
90 / 115

2.Micko’ Pocket

1 x micro: bit 1 x micro: bit Expansion Board

1x Knob 1 x Colorful LED strip 1 x micro USB Cable

3.Dream of Cat

Can | play different music
and make the LED band
flash different colors by
rotating the knob with
different angles?

)When switching the knob, the analog value of the pin the knob
connected changes from 0~1023. We can divide them into 8 small

ranges, corresponding to one octave “Do~Do” and the number of LEDs

to be lighted. V




Welcome to the DFRobot blog: https://www.dfrobot.com/blog-tag-microbit.ntml

91 /115
The input value of Knob(P1) Sound The LED strip

0~128 Do Light up one LED
128~256 Re Light up two LEDs
256~384 Mi Light up three LEDs
384~512 Fa Light up four LEDs
512~640 So Light up five LEDs
640~768 La Light up six LEDs
768~896 Xi Light up seven LEDs
896~1023 Do’ Light up seven LEDs in blue

Table 4.2.1

4.Micko’s Blackboard

STEP1: Connect the knob to Pin P1 of the expansion board, the LED strip to P2.

Figure 4.2.1 Connection Diagram
STEP2: The following logic diagram will help you to build a general idea about

how to realize a DJ Bandstand.

Octhe value of " 128<the value “" 768<the value ‘
Ple=128 - S~ of P1<=256 TN of P1<=896

'i YES l YES T YES ‘ ‘
Light up 1 LED Light up 2 LEDs Light up 7 LEDs Light up 7 LEDs ‘
of the LED strip of the LED strip of the LED strip of the LED strip in blue

T I ] ‘

Play the sound "Do” | | Play the sound “Re” | | Play the sound “Ti" |

Figure 4.2.2 Flow Chart
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STEP3: Programming

1. Take programming “0<knob P1<128" as an example, set the range of Knob
P1 through the “and” function in the “Operators” module, then put the set
range into the condition of “if...then...else” block, nest the LED strip and
sound effect blocks inside the “...then..."” function, and add a “wait |

second” block. Show as below. The rest 6 programs are similar to this one.

(® microbit starts

71§ pin P2~ (@ RGB lights Brightness €

if @@ readanalogpin P1- > and @® read analog pin P1~- <= @) _then

71§ pin P2~ clear

7§ pin P2+ 0 to @ Leds show color

&» pin PO~ play note QUGLICI®{e&Y for 1~ beat
wait () seconds

Figure 4.2.3 Sample Program 1
2. Since there are only 7 LEDs, so we can use different light effect to express
the sound “Do" in the eighth section as shown below.

if (2 read analog pin P1+ > and (= read analog pin P1~ <: then

77§ pin P2+ clear
771 pin P2+« 0 to 6 Leds show color

@® pin PO~ play notefor 1~ beat

Figure 4.2.4 Sample Program 2

QS <f
cﬁr, Mr. Micko, this program is not too hard. It is

NC®, just a little complicated.
G

-
Yes, here we can use the copy and paste in

coding.

.
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S mioochit storts

171 pm P2+ (@ RGE Sghes Brightne=s D)
forover

" 9 madamiogpn Pi. >@) and % madaciogpn Pi. < 5 tos

741 pin P2+ dear

fit pin P2. (& o @@ Lods chow collor

&= pin PO~ play now EEEETIRE) for 1 - boat
waitt ({F) ssconds

" ) madaaiogpin PT. > @QE) and 9 madamiogpn Pl <= B9 then
il pn P2+« dear

fit pin P2. (& o @ Lods chow color

G5 pin PO~ play mow QUEETYEED for 1- bese

watt ({5} ssconds

o G 9 end analog pin PT - »@ and < vead anaiog pin P1 - <-@ thon
il pn P2+« dear

fit pin P2. @ o @ Lods chow coler @
G5 i PO~ play mowe QUERTIED) for 1 boat

fit pin P2. @ wo ) Lods show color
&= pin PO~ play now QEEERENE) for 1 beat
watt ((F) ssconds

o G 9 vead aalog pin PT - >m and &4 madammiog pin P - «'-@ then
il pn P2+« dear

fit pin P2. () o ) Lods chow collor

&5 pin PO~ playwow EEEETENED for 1 - beat

watt {5} ssconds

o ¢9 madamiogpn Pi1. > (5 and 9 madamiogpn Pl <= &) then
il pn P2+« dear

fit pin P2. (@ o @ Lods chow collor

&= pin PO~ play now QEEETEND) for 1- b

watt ((F) ssconds

" 9 madamiogpn Pi. > @) and 79 madamiogpin Pl <= EE) then
il pn P2+« cear

fit pin P2. (@ o @ Lods chow color

&5 pin PO~ playwow EEEETEED) for 1- bt

watt ((F) ssconds

" ¢9 madamiogpn P1. >EEY and 4 read aniog pin P - (-E then

{1 pin P2+ dear

fit pin P2. (& o @ Lods chow collor

& pin PO~ play now CINYNEY for 1- boxt
watt (8} ssconds

Figure 4.2.5 Run the Program
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3. To convenient operation, we can make a little bit improvement, such as

add a handle to the knob, or mark the range of each sound.

— 1 D |
//.

Figure 4.2.7 Improvement 1 Figure 4.2.8 Improvement

5.Invention of Cat

Z Mr. Micko, | am so exciting to make my own

DJ bandstand.
\

f

My dear, do you want to improve your DJ
bandstand? Try using the 5 x 5 LED dot-matrix
in micro: bit to display notes!
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Project 3: Automatic Door

1.Story of Cat and Micko

Mr. Micko, please help me. Yesterday a friend of mine

@ visited me and knocked the door. But that time | was
\(t listening music in the room and did not hear the
S knock. Then he was mad and went away.

Poor baby, you would better
explain it to your friend

@ Yes, | will. But | am afraid it will happen
N again in the future. What should | do to
‘- avoid this problem?

Why not try make a remote-B
control doorbell? So you

can hear the knock even
you are in your room.

G J

\
@ Bravo! Mr. Micko, how wonderful fo make a
\‘ ~ remote-control doorbelll So | will never
(k need to worry about missing knocks
J

Ha, ha, let’'s make it!
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2.Micko’ Pocket

vl

2 x micro: bit 2 x micro: bit Expansion Board

. @
o2r @ i2r .3.

1 x LED Module 1 x Push Button

® -

13
LI = D

1 x Motion Sensor 2 x micro USB Cable

3.Dream of Cat

I want to know is there
anybody knock the doorbell
even | am staying at my room.
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L) ﬁ
0@ Mr. Micko, why should we use 2 boards now? ]

NCW,

(Well, we need to use these two boards to imitate
remote doorbell. We will put one of them into
outside, which is equals to doorbell. This is the
server. And we will put the other one into yourroom
to receive the signals from the server. That is the
client. So you can know the outdoor even you are
\siaying your bedroom.

: , _\_ Mr. Micko, what should we connect between

the server and the client?
NCW L

-

At this time, we need to apply the
knowledge in the flash LED, the notification
light and the automatic door. Let’'s come to
the Little Tips to check what should be
connected!

Judge whether there is somebody

ringing the doorbell

| Tareriver R
Judge whether there is somebody
-y

approaching the door
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4.Micko’s Blackboard

STEP1:

Hardware connection of micro: bit transmitter.

— i

RE

Figure 4.3.1 Transmitter End

Hardware connection of micro: bit receiver

wll

Figure 4.3.2 Receiver End

STEP2: Get to know about wireless fransmission module

Mr. Micko, How could we send the signal if
someone knock the doorbell from the server?

Here we need to learn a new thing:
wireless tfransport module. When the
server receives the signals from users, it will
pass the signals to the client. So we need
to program the server and the client
separately.
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The common wireless transmission module

Signal Sefiing:
Transmitting wireless signal:

Receiving wireless signdl :

Notice: the receiver end needs to recognize the received signals so as to

execute the related actions. The tfransmitter can send out both figures and
letters. V

STEP3: Program the transmitter

1. The following flow chart can give us a roughly idea of how to write the

program.

N

Is there somebody

NO

Is there somebody

ringing the doorbell? approaching the doorbell?

(button)

| Send number “2” —_—
(motion sensor)

Send number “0” | Send number “1” |

Figure 4.3.3 Transmitter Flow Chart

Mr. Micko, how to set the wireless connection?

(87
L/

f

Good question, we must open the wireless
communication module before
programming and sef the wireless program.

\_
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2. Programming according to the flow chart.

(9 micro:bit starts

@®» Turn on~ wireless communication

(= setwireless channel a

if @9 read digital pin PO~ = () _then

@» send string i) via wireless

if (= read digital pin PO~ () read digital pin P1~

@ send string (] via wireless

if (@ read digital pin PO~ (® read digital pin P1~

(== send string e via wireless

Figure 4.3.4 Transmitter Programs
STEP4: Program the receiver

1. Draw the flow chart, design the receiver programs.

NO

Whether the received
number is “2"

Whether the received

number is “0”

Whether the received
number is “1”

| Display a “smiling face” | Display a “house” LED lights go off

l

| LED lights flash |

Figure 4.3.5 Receiver Flow Chart

Little friend, here we also need to open the wireless
communication module before programming and set the
wireless program, and execute the program when the client
receives the wireless signals.
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2. Programming according to the flow chart.

&® microbit starts (*® when received wireless data

(&9 Tum on~ wireless communication | if @9 receive data from wireless = (i) then

(&9 setwireless channel o @ display built-in pattern

@@= hide all dot matrix repeat o
(@9 setdigital pin P1~ output HIGH ~
wait {&) seconds
(9 setdigital pin P1~ output LOW ~
wait @ seconds

if 9 receive data from wireless = () then

@9 display built-in pattern

if (9 receive data from wireless = then
(@ hide all dot matrix

(= setdigital pin P1~ output LOW ~

Figure 4.3.6 Receiver Program

Sweetie, please do not forget “0”,”1",72”
when reading the signal(please remember
the string we read should go with “”).

Result

1. When there is someone passing by but not ringing the bell:

Display pattern 1

Figure 4.3.7 Result 1

2. When there is someone ringing the bell
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Figure 4.3.8 Result 2

5.Invention of Cat

Sweetie, please do not forget “0”,”1",72"
when reading the signal(please remember
the string we read should go with “")

’c@:
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Project4: The Bomb Escape

1.Story of Cat and Micko

Mr. Micko, my best friends will visit me.
I want to play games with them.

[ Good idea. Which games would you prefer?

Some interesting games. Such as
remote-control cars, and planes. But |
want to play new and cool toys.

\.

7

Well, but why not make it by yourself?

\

Yes, | was planning to make a game to\
escape from bomb. This game can test our
reaction ability. Mr. Micko, will you do me

a favor?

\_

No problem! It's my pleasure. Let’s start to
make it.
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2.Micko’ Pocket

1 x micro: bit

]

1 x Colorful LED Strip 1 x micro USB Cable

3.Dream of Cat

When we start play the game Bomb, the
LEDs also enter the countdown mode at
the time. When all LEDs are OFF, which
means the countdown is over. The bomb
will explode imminently.

If we went to disposal the bomb, we
need to lean the micro: bit to the
directions that LEDs show.

&

Ae explosive ordnance disposal device includes following three parts :

1. Action Recognition: identify if the tilt direction of the micro: bit board is

same fo the direction its LEDs pointed.

2. LED Strip Countdown: set countdown light effect to the LED strip, turn off

1 LED every 10 seconds.

3. Score System: if the 20 actions are finished before all the LEDs of LED strip

go out, you win; otherwise, game over.
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4.Micko’s Blackboard

STEP1: Connect the colorful LED strip to pin PO of the expansion board.

Figure 4.4.1 Connection Diagram

STEP2: Action Recognition

1. Learn the related commands

Firstly, we need the micro: bit board to generate and display a direction
randomly, then tilt the board, if the direction the board tilts to is same to
the displayed direction, generate a new random direction, if not, micro:

bit LEDs panel keeps displaying the current direction. The flow chart is

shown as below:

‘ Start ‘

|

| Generate a random direction |

The direction the micro:bit board
tilts is identical to the arrow’s
pointing direction.

Figure 4.4.2 Action Recognition Flow Chart
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ot Mr. Micko, how to create a direction in
) arbitrary?

[ Here we need to use the module random. F

94 Mr. Micko, how could we combine the
@ module random with directions?

Such a good question! Here we need to learn
something new, that is the module “Create a
function”, check it at the Little Tips!

Select a random number:

Use the “pick random...fo...” function in “Operatfors” module to select the number
in a certain range. Since there are four directions (up, down, left and right), we can

use number 0~3 to represent four target directions respectively.

Construct functions:

Use the "make a block” in "My blocks” module to construct a function. When it is

constructed, drag the block to script area if we need it.

Now we need to make the four numbers “0, 1, 2, 3" correspond fo the four
directions “up, down, left and right”. We can make a “generate a random

direction” block. The constructed block will appear in the left.
o

My Blocks

Make a Block

- - ﬂ generate a random direction
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et the current gesture :

Use the “current gesture” function under “micro: bit” module to sense

which direction the micro: bit board filts.

2. Programming

1) Create avariable “farget direction” to represent the arrow’s direction on

micro: bit LED panel, set the variable value to “pick random 0 fo 3"

set target direction » to pick random () to €

Figure 4.4.3 Set the value of target direction

If you forgot how to create a variable, review it at project 4-light up

a colorful LED strip.

2) Create a function “generate a random direction”, and make the four
numbers “0, 1, 2, 3" correspond to the four directions of the arrow

displayed on the LED panel.

define generate a random direction

if target direction = i _ then

display built-in pattern

target direction = @  then

display built-in pattern

target direction = @@ _ then

display built-in pattern

target direction = (€J) _ then

display built-in pattern

Figure 4.4.4 “*generate a random direction” function
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3) Make a variable “operation direction” to represent the current direction
the board filts, and use it with “current gesture” to make the four

“operation direction” correspond to the four numbers.

if  (® current gesture logoup ~ ? _then

operation direction ~ to o

&9 cumrent gesture logo down ~ ? _then

operation direction ~ to o

(@ cumrent gesture tilttoleft~ ? then

operation direction - to e

(@9 cument gesture tilttoleft » ? then

operation direction » to e

Figure 4.4.5 Get the current gesture
4) Here we need to use a "if...then...else”. If the operation direction is same
to the target direction, then continue to generate a new random

direction.

if target direction = operation direction _ then
set target direction -~ to pick random o to e

set points+ to points + (P

generate a random direction

Figure 4.4.6 if...then...else
5) The whole program of this part is shown below:

microzbit starts

set score - to @

set target direction = to pick random (& to €
@o display built-in pattern

target direction = @

@ display built

target direction = @

@ display built-in pattern

current gesture tilt to right = 7 _then

generate a random direction

Figure 4.4.7 Programs of action recognition
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STEP3: LED Strip Countdown
1. Draw a program flow chart

The LEDs on the LED strip will go off one by one as the time goes by. The

faster you react; the more LEDs keep on at last.

| '/z\k
N
/,/ \‘\ NO
e .
‘ & time<10 seconds > >| time =0 | the number of LEDs=the number of LEDs-1
‘\», ./"

Figure 4.4.8 LED strip countdown flow chart

2. Programming

1) Create variables “time"” and “the number of LEDs”, set “time” to 0, and
set “the number of LEDs” to 7(means 7 LEDs keep on). Combine them with

Yif...then...else” to write the programs as the flow chart.

@ Note: micro: bit needs extra time to process the data, so the clock

will run a bit slower than we set.

o e -

set time - to time + @
1

set the number of LEDs - to the number of LEDs - P

Figure 4.4.9 “if...then...else”

2) Remember to set the LED's lighting effect:

Til pin PO~ o RGB lights Brightness @

¥il pin PO~ 0 to {the number of LEDs ' Leds show color

Figure 4.4.10 LED Lighting Effect



Welcome to the DFRobot blog: https://www.dfrobot.com/blog-tag-microbit.ntml
110 / 115

3) The whole programs of the last two parts:

set the number of LEDs = to  the number of LEDs - (§])

7i pin PO~ (g RGElights Erightness EE

7¥i pin PO~ dear

7Ti pin PO- (@) to (the mumber of LEDS) Lads show color

Figure 4.4.11 Whole programs of the last two parts

ole <f Mr. Micko, 10 seconds is a little oo long.
@ We want to speed it up!
NCW, \.

r
No problem, if you want to shorten the

countdown time, try set the time to 5s or
1s.

.

STEP4: Score System
1. Draw the flow chart

If the operation direction is same as the target direction, then we get 1
point. If the number of LEDs (keep on) is over 0 when we got 20 points, we

are the winner, the final score is the number of LEDs (keep on). Otherwise,

we failed.
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Here is the flow chart:

the number of LEDs >0

| score=the number of LEDs{on}+1 ‘

Figure 4.4.12 Flow chart of score system
2. Programming

1) Create variables “points” and “score”, set them to 0. Combine them with

“if...then...else” function to meet the requirements of the flow chart.

Figure 4.4.13 Part of the Program

()&
\ Mr. Micko, why the final score is equals to
( the quantity of LEDs + 1?

My sweetie, do you remember? The LEDs are
counted from 0. So the number of LEDs turn ON
in reality is just Tmore than the number in
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2) The final program is shown as below:
= microchit starts
the number of LEDs - 1o () (“Eﬁ"e Mam"irﬁﬁ"q
set time- to (i) if  tagetdirection = (i) then
set poins - 1o ) P —
set score - to i)
set target direction » o pick random (i) o E) i targetdirection = (§)
— & display buit-in pattem
i == cumentgesture logoup= ? then
st operation direction = 1o i) i target direction = ()
B @3 display built-in pattem
if 9 cumentgesture logodown - ? then
set operation direction - 1o () ¥ targetdiecion =(§) then
if 9 curentgesture tilttoleft- ?  then €3 diay fnik-inptiem I
set operation direction - 1o )
if (9 cumentgesture tittoright= ? then
set opertion direction » 1o ) n Function defines
if  targetdirection = operation direction  then
set target direction « o pick random (&) o )
= [FE=s o=+ O |8 Action recognition
generate a random direction
if tme <) then
set time- o tme +
wait i) seconds
else
set time - o )
set the number of LEDs » to the number of LEDs - )
7§71 pin PO~ i) RGE lights Erightness (EEE)
i gin PO- dear LED strip countdown

77§ pin PO- i) 1o (the numberof LEDs Leds show color
[ the number of LEDs = i} “then
if points =) then

set score - to  the number of LEDs +“

% display score
vait [ seconds

Score system
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5.Invention of Cat

ol Mr. Micko, the game Bomb is so
@ interesting! We all have fun!
N W,

Little friend, if you want to upgrade this
game, you can create a mark in the
end of the game. Come to explore this
interesting work with your friends!

\_

<) @:
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@ Mr. Micko, micro: bit and Mind+ are so
QE interesting! They are so powerful!
(

-

My little friend, what we played is just
the tip of the iceberg. There are so
many functions in micro: bit and

Mind+, and they are waiting for your

J

~N

exploration.

\_

@ Mr. Micko, thanks for all your help all this
N time. | will explore it with enthusiasm as
k always. But where could | find you and

ask you my problems?

J

[Do not worry, | am always with you on line. If you got any
problems and any good ideas to share, come to visit the

DFRobot Community: www.dfrobot.com

In this community, you can find many makers like you. Wish
DFRobot community can record your growth.

\_

~

@. Wow! So wonderfull Mr. Micko, see you in
A the DFRobot community, wishing | could
o find more friends in the community.

J



http://www.dfrobot.com/
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